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Figure 1. LV8702VSLDGEVB Board

EVAL BOARD USER’S MANUAL

Figure 2. ONBB4AMGEVB Board with
Arduino Micro and LV8702VSLDGEVB

Board
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���：

•�PC
*� OS: Windows 7/Windows 10, 64 bit
�&Internet
('(�)� “Including the TimerOne Libary” *� )
+�Arduino IDE 1.8.4 3) 

��,-�

•���
AC ��.  /�0：9~32 V

 /�1：~5 A
��.�2

32：�4	5

672.1 mm、875.5 mm
*�：WSU120-1000 (Triad Magnetics)
9"��#1��，:�;$.

�	��

�	

•�LV8702VSLDGEVB：������

•�ONBB4AMGEVB：�


•�Arduino Micro

•�USB % (Micro B−A)

•�Flat−tip Screw Driver

•��&�� MDP−35A 
(Nidec Seimitsu, Step angle = 7.5 deg, 12 V/300 mA) 1 pc

		

<���=�'�()��*��LV8702VSLDGEVK+�>?.
http://www.onsemi.cn/PowerSolutions/evalBoard.do?id=LV8702VSLDGEVK

. . . Arduino IDE&'�

. . . GUI as well as .NET Framework4.6.1 Installer

. . . .NET Framework4.6.1(
)�

. . . API*

. . . GUI − Arduino Firmware

3) +��,�-./01，345./6&'789:�

http://www.onsemi.cn/
http://www.onsemi.cn/PowerSolutions/evalBoard.do?id=LV8702VSLDGEVK
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�

���LV8702VSLDGEVK_SOFTWARE.ZIP@A�
?�B,

C(DLibraries\Documents 9Desktop).

API �
��)
-�Arduino+MicroE�FG�

1.HIGUI�Arduino�sketch

.�/0Arduino
IDE.(J12�, “How to install Arduino IDE”,
DKArduino IDELM+�)

IDE�N3���)，OLV8702_Program.ino=
�45�PA�F。QI“OK”67。

��)�N38.ino=�@M�RS�=�T
�(D.Sketch12345.inoU9�Sketch12345=�
T�).

2.VWAPI�
D�<3,X? “Sketch → Include Library →
Add .Zip�Library”

�/:��;Y。<Z“LV8702_APILibrary”
=�T,@D�<3A��=�T.
[PQI=�T@\ “Open”=，�]HI=
�T.

>?'^_@�，VWAPI_@�`-��P。

��TimerOne�
D�<3,X?“Sketch → Include Library → Manage

Libraries”

�a���.�b, ��AB c“TimerOne”dX

*;�<=>?	@A�BCD

http://www.onsemi.cn/
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�dXCK�<Z@+� “TimerOne”

��Arduino
�

・��Arduino
1.<Z Arduino
，()X?

“Tools → Board → Arduino/Genuino Micro”

2.e��Arduino sketch， fgh?
“Sketch → Verify/Compile”

IDE����g_DEFGh�N3“Done
compiling”.

3.!"USB�&PC,Arduino Micro
@<ZijCOMY，D�<3

4. ��sketch()\“Sketch→Upload”

9\ =

���)
�，Arduino Micro bootloader�4
+�.

The IDE will display “Done uploading” after 
a successful upload to the Arduino

e?Arduino�Sketches��4k>，>?H^
ec

8��
�lI，�md1.FG
S�3.md
�Y��

http://www.onsemi.cn/
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��Arduino
�

D�1.9�2., �H^ec
�? Arduino
1.O'^API_@�
a)n>Oo API_@�，X?

Documents\Arduino\libraries@n>
LV8702_APILibrary =�T.

b)VWp^�API_@�. ��qp^�API
_@�?PC��rs�PC,C.
(JJ5�K, “Software Setup”)
p^API_@�.
(JJ5�K “API Library”)

c)DE@e
�? Arduino
(JJ5�K, “Writing and Compiling with the
Arduino IDE”)

2.OL LV8548 DC�t!������
("�t!�������uM4VW)
a)DE@e
�?Arduino

(JJ5�K, “Writing and Compiling with the
Arduino IDE”)

DK��5�PvNt!�#�������，

�JOijPw�xy.

GUI��

1.HI

=�T@JzD

�<3�&
 

*8{oGUI|} (ON_MD_Module_Kit_GUI)
uM+�，�~�@ +� GUI

2. .NET Framework4.6.1 i+�;Y��N38PC
��-Q�|}. DK.NET Framework4.6.1
M+�,QI Accept+�.

��;YN3+�)
. (�������	
)

8+�-QHb�fg，���)����N3。

�\ “Yes”Hb.
Hbh，�P/0

http://www.onsemi.cn/
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3.+�GUI. 
\“Next”

4.F�+�=�T，9\“Next”67+�

�\“Next”.

+�F�@-Q���-�。DKR���N3，

\“Yes”.
�����N3�g_+�h.

F�GUI������STg，D�<3，F�

�$uM��?windows��U[

EFGHI

JKLM

http://www.onsemi.cn/
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�	
�

1.�� LV8702VSLDGEVB�(������)?
ONBB4AMGEVB�(�����
).
����c�
，�B�Q���V.

2.��Arduino/Genuino Micro?�
,
D��<3. USB�YD�
 “←USB”
��Arduino��

1.

2.

3.�c���%�(WX5 mm − 10 mm)?�
 /
Y�- OUT_A/B/C/D (CN5).
�Z%���%[���?Y�.
JJ�\����:

OUT_A A (Blue)

OUT_B A (White)

OUT_C B (Yellow)

OUT_D B (Red)

Motor Wiring
Diagram

(�U�4]^�%，�5F�%@��i_�`g
�&)

4. ��USB��Arduino ? PC .
5.�cAC����.?�
�Y(D��)。F�
��Center*-#./��.，$0�1
9~32 V.
8����%，���53Y�?VCC，�3
Y�? GND (CN6��.). The power supply
terminals CN6�+/−�%&23.4.
(VCC = +, GND = -)

4.

CN6

CN55.

3.

http://www.onsemi.cn/


LV8702VSLDGEVK

www.onsemi.cn
8

����GUI

15 16 17

18
1 19 21 20

3 2

12 136
5

8 7

4

9 10

11

18

14

1.HI�S�GUI�=@��COM�Y.

@�� COMY�N3���U[�. 
DKArduino#���? PC,�<ar “Arduino
Micro (COMx)” �N3 (ij��Y);
<Zb� COMY@QI��.

2.��Arduinoh, GUI �c�X? LV8702 �
3.��d��@_@

OLV8702V�@_@A�
�_@
������� .

[��] … ��� 
[��] … ��� 

4.����¡e�¢
��

 � ( ��") #��$�%

�N 1/1�f

ON (�PQ) 1/2�f

ON (�R) 1/2�f

S���N 1/4�f

�\£gLV8702 data sheet �h

GUI �� Data Sheet ��

�N 1/1�f

ON (�PQ) 1/2�f

ON (�R) 1/2�f

S���N 1/4�f

http://www.onsemi.cn/
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��:

'CW - iFV
'CCW - jFV

k¤: ¢
���@lm�% ¥¦n¥¦

5.�� /�1

 /�1�������o§6(¨p�©)，
#$ 10. ()ª�9�«p�©6�(.
��(���0.01�Aq¬,*�r­®?Arduino
�����.

k¤:  /�1��	0.3�[A]�	J1
�����.b�F，�PRs¯���°

-H^�t.

6.�����&f

k¤: �&f�lm��¥¦.
DK��VW�J1��，��t	 7.5°

�&f�����
���“RPM”�t��q[±
��“­”�t

7.����
�step/s9�rpm

step/s (=pps): ²uv�³wx
rpm: ²!v��
�

�&���´µ¶��,y)p·
�F$�¸T¹
�.O��VW�J1�����AC��.F，�#
$�\��
�.

�N 1~560 step/s 2~700 rpm

ON (�PQ) 1~1120 step/s 1~700 rpm

ON (�R)

S���N 1~2240 step/s

8.��[+����º�
�»�(.
O�����
�»�C¼h，���,½@

�¾¿z.
'5��6(!"��，78)9��.
�<Z Free\=,½{��
�. 
8°��¢
F�，<Z0 (Infinity)

/1: 
��� 10 *
Transfer Unit = Seconds
Transfer Time = 10 [seconds]

/2: 
��� 100 �
Transfer Unit = Steps
Transfer Step = 100 [steps]

/3: ¢
�� 180:
Transfer Unit = Degree
Transfer Angle = 180 [degree]

http://www.onsemi.cn/
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9.O\Start=h，��¢
。DKÀ¥ /�
1，¡e����­，À¥��\Start=hT
".
8QÀ¥¢
��，*�{\Stop=,À¥(，
¶h�\Start=����¢
. 
\�,½=Á|��,½，@0�¾¿z.
O\� Free=，��,½@lÂ¿z.
	�¾��
�F�+t，9Ã,���<P

R+tb�，<ZStop=.
�F，Ä	��;+�"��，78)9��.

10.����������

Supply Voltage... ���0
MAX Supply Current... p·���1
Motor Rated Current... ��}��1
Motor Winding Resistance... ��%Å~Æ
Max Output Current Set buttons...
<����(��/�p· /�1, @0
5.�� /���1?��+����o§.

11.���"��_@.
(�_@��>�9���o§6��，Ä	Ç
��º�@"�mv?.�_@$�@���F
È:.)
�"��_@c�#$���
�?¦���

1.�b�_@，_�，É，¹�，ÊËÌ��
>.�"��_@VW����J³.

<,... ON/OFF �"��_@�w
O�"��_@A�F，���1�5.���
o§6c��Í。

��=:... Î­�Í_@
<pÏ�1�ÍÎ­��
���.
OÎ­��	p>，�1Ð�pÏ，*�

boost−ups³��@�Ä	Ï��¥¦n�
�。Ä�，���¹�@H�j�F��Î­

·�A。

�$&% �'(� )��

T �

UV

W

X

�

�

Boost Up... boost−up��
��
�)
�������1@��¾
��ji

���F¹�。

��boost�·BÑI��~Æ，*���B¢

"�2.

�()����Î­Ò�pÓÔ
�"�2.

Boost Up )�� *����

�T W

X

Y5

	Y5

�

Z

��

12.��Ht_@.

Ht_@Ht¡e+t�����.

[ON]... Reset ON
[OFF]... Reset OFF

>�?-�%.

13.��0_@

14.ÕÖmv_@

15. GUI����
16. GUI#$�N3
17.×Ø_@

J12��>'(�)

18.w�GUI
fgh，\��¨��“Exit”
=9�QIABU[�“Exit“<a�/GUI.

O�/GUIF��Ù/©�N3.

<Z“Yes”�/.
<Z“No”ÚÐ�/@�ÛC��.
DKGUI���
�Fw�，���,½@0;Y
�w�.
'(���)，J1��B!D#��GUIÜÝ:

19.��qGUIÜÝ
20.�Þ>GUIÜÝ
21.�
�Tg

http://www.onsemi.cn/
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����GUI+,

GUIÜÝ��N3�?Arduino��0³$��ß�
API_@

i. Set Step Angle

ii. Start Motor 
Rotation
Executed

iii. Stop Motor 
Rotation
Executed

iv. Free Motor 
Rotation
Executed

19 2021

i. Set Step Angle
Executed

ii. Start Motor Rotation

iii. Stop Motor Rotation

iv. Free Motor Rotation

19. �q GUI ÜÝ
\“SAVE”=，N3���ÜÝ6
�4�q?
�� .txt =�9��� .csv =�.

20.Þ>GUIÜÝ
\“CLEAR”=，N3���ÜÝ�6
��4
k>。

21.
�Tg

\“Generate Program”� /��ÜÝ��à0
�API_@?��.ino
�=�，�#���
Arduino.()e /.ino=�? Arduino,
������c�à0GUIÜÝTg�1
[
�G�.
'(Arduino
�Tg_@�)，2��
21. Arduino Program Automatic Generation.

http://www.onsemi.cn/


LV8702VSLDGEVK

www.onsemi.cn
12

�-

Arduino IDE��

1./0<áD�����ZIP=�� @

(����������，�������� 
!"#)

2.+�FO�@RB»â�»�@\“Iagree”\=

3. �¾�����t+�@\“Next”

4.��+��7@\“Install”

5.�+�Arduino USB ��
� Arduino USB ��
� Genuino USB ��
� libusb−win32
� Adafruit Industries LLC Port 

(COM and LPT)
� Linino Port (COM and LPT)

6. ��N3��fg�Arduino IDE+�，�\
“Close”.

789101112

http://www.onsemi.cn/
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�.GUI��

����ij����ãä��“D#��GUI”B
!.
13.��0_@

READå3��©���0 
VREF… /���1J1�0
å3J1�0	5. /���1��
VREF = ( /���1) × 5 × 0.22 �

14.ÕÖmd_@

�æ��³.N3LV8702<²� /Y�
(DST1, DST2, MONI)mv?ÕÖ.
OReal�Time�UpdateA�，�cY�� /��
F�Ú�å3.
Close to Stall��Stall Detected��"��_@
�bF�",@0¸TP³N3E�ç�。
.��³��\ClearHt (p·³255)
OReal Time Updatew�F,ÕÖ#F\Read\
=�N3.

(è:

(è»�(DST1:H, DST2:H)

��é
:

��mvl�ê�(DST1:H, DST2:L)

mv?é
:

��mvl�ÕÖ(DST1:L, DST2:H)

�ë：

mv /Y�����ì���íIC)ÉÕÖ
(DST1: L, DST2: L)

���Ñ�®]^:

mv�ÊË ¥?LV8702STEP cY��¡
���+tF¢(MONI)

wEî�:

O£¸)É�ï，<� /wE，��,½。

Oð­��，�ëÕÖÂ>��H^b�。

O£¸ /Y����ï<� /wE，��

,½。

.�ñò��Ht，()
�Chip Enable/
Disable��-��-��。

15. GUI����

��()«��;YU[À¥��. 
������@À¥(�¤¥E����3)

�B[\5�])

http://www.onsemi.cn/
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16. GUI���3å3
GUI()USB�Arduino$%&'()*'API
_@

OAPI�3A�，���R\=���å3P
wó¦�_@.

API��?AB;Y�ToolTipModeU[w�

17.×Ø_@

<×ØU[��¤?GUI�API|}�)�í�
0(��§.

<ZAbout�N3��;Y.

181920

^_

GUI./

API./

<ZSerialPort�å3�0(¨ô©.

21. Arduino 
�c�Tg

��GUIF,c�Tg�ArduinoGª� /?Ü
Ý;Y.
�� /Gª?��Arduino sketch (.ino)
=� ，��� Arduino IDE�¡��.
�ac�Tg�Gª /? Arduino IDE,
��<GUI�H&
.

1) Tg�eArduinoGª
\Generate�Program�A����q=�i«

�<Zõö��7�q(DDesktop9�
Documents)@\Save

O��GUI, 	
�S,
Ä�-Q��t!�RS÷��q /=�.

http://www.onsemi.cn/
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HI^�Arduino
�A�Arduino�IDE.

GUI�Arduino�IDE�@RF��?PC.�8��
Arduino
�，��/@<ZE�GUI,@�
Arduino�IDEà0��。
��I¬�����ãä5�K

“DE Arduino
�–e?Arduino”

2) ��Tg�Arduino
�
�²�API6Tg�
����h，��c�
�delay(0).�()À¥ø­_@�
argument(0)*�(,������BÀ¥
�F
�，�²�APIQùà0�®F�。.���
�¯?-Q�[���。

*J³[+�úu (û!��u). 8Qø­�u,
��delay(1000).

[À¥�®F�3/]

�/

“motorRotationDeg(10, 720.0, 0, 0)”
will start the motor with Full step, CW, 10
Step/s,and an angle of 720 deg
“delay(5000)”
will drive the motor for 5000[msec]

(5s)
“motorRotationStop()”
will stop the motor

O���øFãJF�)h，��»ãJ��

à0。

DKø­��	09�ü�,�A��G��ý
�fg，��@°þ�?。

k¤: �������F�øF����^�USB�
�，ArduinoHt，9�����sketch?
ArduinoFà0。�F，Oec���tF�ø
F5u.

http://www.onsemi.cn/
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Figure 3. LV8702VSLDGEVB 123
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Table 1. LV8702VSLDGEVB 45

Designator Qty. Description Value Tolerance Footprint Company Part Number

IC1 1 Motor Driver − − SSOP44J ON semiconductor LV8702V

R1−2 2 Thick Film Resistor 0.22 �,1 W ±5% 6432(2512Inch) KOA SR73W3AT**R22J

R3 1 Thick Film Resistor 15 k�, 0.1 W ±5% 1005(0402Inch) KOA RK73B1ET**153J

R4 1 Thick Film Resistor 100 k�, 0.1 W ±5% 1005(0402Inch) KOA RK73B1ET**104J

R5−11,
R18−19

9 Thick Film Resistor 47 k�, 0.1 W ±5% 1005(0402Inch) KOA RK73B1ET**473J

R12−14, R16 4 Thick Film Resistor 47 k�, 0.1 W ±5% 1005(0402Inch) KOA RK73B1ET**473J

R15 11 Thick Film Resistor 12 k�, 0.1 W ±5% 1005(0402Inch) KOA RK73B1ET**123J

R17 1 Thick Film Resistor 15 k�, 0.1 W ±5% 1005(0402Inch) KOA RK73B1ET**153J

R20 1 Thick Film Resistor 100 k�, 0.1 W ±5% 1005(0402Inch) KOA RK73B1ET**104J

R21 1 Thick Film Resistor TBD, 0.1 W ±5% 1005(0402Inch) TBD

R22 1 Thick Film Resistor 27 k�, 0.1 W ±5% 1005(0402Inch) KOA RK73B1ET**273J

JP1−3 3 Jumper 0 �, 1 W ±20% 1005(0402Inch) KOA RK73Z1ET**

JP4 1 Jumper 0 �, 1 W ±20% 1005(0402Inch) KOA RK73Z1ET**

C1 1 VCC Bypass Capacitor 10 �F, 50 V ±20% 5 x 5.5 Wurth Electronik 865080642006

C2, C3, C5,
C6, C8

5 Ceramic multilayer
Capacitor

0.1 �F, 100 V ±10% 1005(0402Inch) Murata Manufacturing GRM155R62A104KE14D

C4 1 Ceramic multilayer
Capacitor

1000 pF, 50 V ±5% 1005(0402Inch) Murata Manufacturing GRM1555C1H102JA01J

C7 1 Ceramic multilayer
Capacitor

150 pF, 50 V ±10% 1005(0402Inch) Murata Manufacturing GRM1555C1H151JA01J

CN1A, 1B 1 Pin header to baseboard 12 pins x 2 − 30.48 x 5.08 Wurth Electronik 61302421121

CN2 1 Pin header to baseboard 12 pins − 30.48 x 2.54 Wurth Electronik 61301211121

PCB 1 PCB − 30.48 x 20.32

`a: bc�dA��6ef
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Figure 4. ONBB4AMGEVB 0123
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Table 2. 6045

Designator Qty. Description Value Tolerance Footprint Company Part Number

D1 1 Diode − − SOD123 ON Semiconductor MBR230LSFT1G

CN1,2 2 Arduino Micro connector − − ∅1.02 x17 −2.54 pitch Hirosugi−Keiki FSS−41085−17

CN3 1 Module connector − − ∅1.02 x12 x2lines −2.54 pitch Wurth Electronik 61302421821

CN4 1 Module connector − − ∅1.02 x12 −2.54 pitch Wurth Electronik 61301211821

CN5,7,8 3 Motor connectors − − ∅1.1 x4 −3.5 pitch Wurth Electronik 691243110004

CN6 1 Power connectors − − ∅1.1 x2 −3.5 pitch Wurth Electronik 691214110002S

J1 1 DC barrel jack − − 9.0 x 14.5 Wurth Electronik 694106301002

J2 1 UART pin headers − − ∅1.1 x4 −2.54 pitch Wurth Electronik 61300411121

C1 1 Electrolytic capacitor 100 �F, 50 V ±10% − Wurth Electronik 860020674015

PCB 1 PCB − − 80 x 60
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ADDITIONAL INFORMATION
TECHNICAL PUBLICATIONS:
Technical Library: www.onsemi.com/design/resources/technical−documentation
onsemi Website: www.onsemi.com

ONLINE SUPPORT: www.onsemi.com/support
For additional information, please contact your local Sales Representative at
www.onsemi.com/support/sales

onsemi,  , and other names, marks, and brands are registered and/or common law trademarks of Semiconductor Components Industries, LLC dba “onsemi” or its affiliates
and/or subsidiaries in the United States and/or other countries. onsemi owns the rights to a number of patents, trademarks, copyrights, trade secrets, and other intellectual property. A
listing of onsemi’s product/patent coverage may be accessed at www.onsemi.com/site/pdf/Patent−Marking.pdf. onsemi is an Equal Opportunity/Affirmative Action Employer. This
literature is subject to all applicable copyright laws and is not for resale in any manner.

The evaluation board/kit (research and development board/kit) (hereinafter the “board”) is not a finished product and is not available for sale to consumers. The board is only intended
for research, development, demonstration and evaluation purposes and will only be used in laboratory/development areas by persons with an engineering/technical training and familiar
with the risks associated with handling electrical/mechanical components, systems and subsystems. This person assumes full responsibility/liability for proper and safe handling. Any
other use, resale or redistribution for any other purpose is strictly prohibited.

THE BOARD IS PROVIDED BY ONSEMI TO YOU “AS IS” AND WITHOUT ANY REPRESENTATIONS OR WARRANTIES WHATSOEVER. WITHOUT LIMITING THE FOREGOING,
ONSEMI (AND ITS LICENSORS/SUPPLIERS) HEREBY DISCLAIMS ANY AND ALL REPRESENTATIONS AND WARRANTIES IN RELATION TO THE BOARD, ANY
MODIFICATIONS, OR THIS AGREEMENT, WHETHER EXPRESS, IMPLIED, STATUTORY OR OTHERWISE, INCLUDING WITHOUT LIMITATION ANY AND ALL
REPRESENTATIONS AND WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, NON−INFRINGEMENT, AND THOSE ARISING FROM A
COURSE OF DEALING, TRADE USAGE, TRADE CUSTOM OR TRADE PRACTICE.

onsemi reserves the right to make changes without further notice to any board.

You are responsible for determining whether the board will be suitable for your intended use or application or will achieve your intended results. Prior to using or distributing any systems
that have been evaluated, designed or tested using the board, you agree to test and validate your design to confirm the functionality for your application. Any technical, applications or
design information or advice, quality characterization, reliability data or other services provided by onsemi shall not constitute any representation or warranty by onsemi, and no additional
obligations or liabilities shall arise from onsemi having provided such information or services.

onsemi products including the boards are not designed, intended, or authorized for use in life support systems, or any FDA Class 3 medical devices or medical devices with a similar
or equivalent classification in a foreign jurisdiction, or any devices intended for implantation in the human body. You agree to indemnify, defend and hold harmless onsemi, its directors,
officers, employees, representatives, agents, subsidiaries, affiliates, distributors, and assigns, against any and all liabilities, losses, costs, damages, judgments, and expenses, arising
out of any claim, demand, investigation, lawsuit, regulatory action or cause of action arising out of or associated with any unauthorized use, even if such claim alleges that onsemi was
negligent regarding the design or manufacture of any products and/or the board.

This evaluation board/kit does not fall within the scope of the European Union directives regarding electromagnetic compatibility, restricted substances (RoHS), recycling (WEEE), FCC,
CE or UL, and may not meet the technical requirements of these or other related directives.

FCC WARNING – This evaluation board/kit is intended for use for engineering development, demonstration, or evaluation purposes only and is not considered by onsemi to be a finished
end product fit for general consumer use. It may generate, use, or radiate radio frequency energy and has not been tested for compliance with the limits of computing devices pursuant
to part 15 of FCC rules, which are designed to provide reasonable protection against radio frequency interference. Operation of this equipment may cause interference with radio
communications, in which case the user shall be responsible, at its expense, to take whatever measures may be required to correct this interference.

onsemi does not convey any license under its patent rights nor the rights of others.

LIMITATIONS OF LIABILITY: onsemi shall not be liable for any special, consequential, incidental, indirect or punitive damages, including, but not limited to the costs of requalification,
delay, loss of profits or goodwill, arising out of or in connection with the board, even if onsemi is advised of the possibility of such damages. In no event shall onsemi’s aggregate liability
from any obligation arising out of or in connection with the board, under any theory of liability, exceed the purchase price paid for the board, if any.

The board is provided to you subject to the license and other terms per onsemi’s standard terms and conditions of sale. For more information and documentation, please visit
www.onsemi.com.
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